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About this course
Objectives of the course
Upon completion of this course, you will be able to:
-Use 3D reference Elements to create a part
-Create advanced Sketch-Based Features
-Apply Advanced Dress-Up Features
-Design using Boolean operations
-Share Designs by working in Multi-Model environment
-Analyze Parts
-Annotate Parts for review

Targeted audience
CATIA V5 Mechanical Designers

Prerequisites
Students attending this course should have the knowledge of 
CATIA V5 Fundamentals, Getting started with CATIA V5, Sketcher, 
Part Design Fundamentals 

1.5 Days
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Using 3D Elements to Create a Part
You will learn how to use 3D elements to create solids based on

Introduction to Using 3D Elements to Create a Part
Local Axis
3D Wireframe Elements
Holes/Pads not Normal to Sketch Plane
Creating Pads and Pockets from Surfaces
Surface-Based Features
3D Constraints
Using 3D Elements To Create Parts Recommendations
Using 3D Elements to Create a Part: Recap Exercises
Angle Bracket
Sum Up
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Introduction 

Part creation is frequently based on 3D wireframe 
elements like lines or planes or on surfaces :

You will see how to create 3D wireframe elements and 
how to create local axis used to position geometries.

You will see how to create solid based on existing 
surfaces and  how to position 3D geometries with 
regards to planes or surfaces.
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Local Axis
You will learn how to create a local axis in order to define local coordinates
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It is possible to create a local axis in order to define local coordinates. For example, it is, 
sometime, easier to build a point by coordinates in a local axis rather than creating it in the 
absolute coordinates system 

What is a Local Axis ?

Point created in the local 
coordinates system
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Local Axis : Creation

It is possible to create a local axis in order to define local coordinates. For example, 
it is, sometime, easier to define point coordinates with respect to a local axis rather 
than to the absolute coordinates system

Select the Axis 
System icon

Select the local axis 
origin point

(2)

Select the OX direction

Select the OY direction

You get :

(3)

(4)

Select OK in the dialog 
box

(5)

54

321
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Local Axis : Use

It is possible to create a local axis in order to define local coordinates. For example, 
it is, sometime, easier to define a point coordinates with respect to a local axis 
rather than to the absolute coordinates system

Set the axis system As  the 
Current one with the 
contextual menu

Using the Point function (Coordinates options), create 
a point with X=0, Y=0 and Z=100

You get :(1)

1 2
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Local Axis-System Setting (1/3)

Check the ‘Create an Axis-System when creating a new part’ option if you wish to 
create a three axis-system which origin point is defined by the intersection of the 
default planes that are plane XY, plane YZ and plane ZX

Select Tools -> Options1
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Local Axis-System Setting (2/3)

In the Options dialog box, select Infrastructure > Part Infrastructure > select Part Document tab2

Select the Create an Axis 
System when creating a 
new part option

3

Select OK4
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Local Axis-System Setting (3/3)

Double click on Part in the dialog 
box

6

Select the File -> New 
command

5

The local axis is 
automatically created:
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3D Wireframe Elements
You will learn more about 3D wireframe elements and how to use them  to 
construct your part.
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What are 3D Wireframe Elements ? 

In the Part Design workbench, you can create points, lines and planes without using 
the Sketcher workbench but by using the “Reference Element” toolbar.

Points ,lines and planes created using reference toolbar are 3D elements can be used 
for reference purpose.

For Instance, you can use this toolbar to create a plane at an angle ,and sketch on this 
plane when existing surfaces of the part do not provide an appropriate sketch plane for 
the creation of a feature. 

You can use the 3D reference line to create a pad in a direction other than the direction 
normal to the sketch.

The Specification tree:
When Points and lines 
are created in sketcher 
workbench using profile 
toolbar.

The Specification tree:
When Points lines  and 
planes are outside the 
sketcher workbench using 
reference elements toolbar

Point and line 
created in sketch

Point and line created 
using reference 
elements
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3D Reference Elements (1/4) 

3D reference elements are used mainly to reduce the impact of deletions and 
optimize the designing of parts and their modifications. They are used to ensure 
consistent parent children relationships.

First case

Create  a sketch on the top face of 
Base Pad. Constrain the sketch 
completely using the edges of the 
Pad. Using this sketch a Upper Pad.

Create a Base Pad 
from the sketch 
shown.

Create  a sketch on the top face of 
Upper Pad. Create a Pocket

Create the holes on the top face of 
the Upper pad. Dimension the holes 
with respect to the Pad edges.
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3D Reference Elements (2/4) 

The upper pad is dependent 
on the Base Pad.

Now when we try to delete the Upper 
Pad, an update error is displayed.

On deletion of Parent feature, the children 
features are affected.

The Pocket is dependent on 
the Upper Pad.
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3D Reference Elements (3/4) 

Second case

Create a ‘Sketch’ for ‘Upper Pad’ on 
the bottom reference plane. 
Dimension the Sketch with reference 
to standard Planes. Create ‘Upper 
Pad’ using this ‘Sketch’.

Create a Base Pad from 
the sketch shown.

Create the holes on the top face of 
the ‘Upper Pad’. Dimension the holes 
with respect to the standard Planes.

Create a ‘Sketch’ for ‘Pocket’ on the 
top reference plane. Dimension the 
Sketch with reference to standard 
Planes. Create ‘Pocket’ using this 
‘Sketch’.

Bottom Reference Plane

Top Reference Plane

The sketch created is independent of the parent Pad but is created with the help of reference 
elements



Student Notes:

Part Design
����������	��

Copyright DASSAULT SYSTEMES �


C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

3D Reference Elements (4/4) 

So parts  created using reference elements 
are more stable.

The upper pad is created on Reference 
elements and is independent of first feature.

On deletion of the first feature Upper 
Pad, the pocket is not affected.

The upper Pad Sketch is created on reference 
Plane and independent on the Base Pad.

The Pocket Sketch is created on reference 
Plane and independent on the Upper Pad.
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A dialog Box is displayed2In the Reference  toolbar, select Point 
by clicking on the icon

1

Notice that you can choose from several 
options from the drop down menu

3

The created point appears 
under part body.

Creating 3D Wireframe Points



Student Notes:

Part Design
����������	��

Copyright DASSAULT SYSTEMES ��

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

A dialog Box is displayed2In the Reference toolbar, select 
Line by clicking on the icon

1

Notice that you can 
choose between 
several types of line

3
The created line appears under 
part body due to hybrid nature

Creating 3D Wireframe Lines
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A dialog Box is displayed2In the Reference toolbar, select 
Plane by clicking on the icon1

Notice that you can 
choose between 
several types of planes

3 The created plane appears in the part 
body because of hybrid nature

Creating 3D Wireframe Planes
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Using 3D Wireframe Elements to Create a 3D Curve

1
You can create points according to their coordinates 
by using the Points tool in the Reference Element tool 
bar

2

Create the 3D curve by using the 3D Curve tool in
the Free-Style workbench

This curve can now be 
used to extrude a rib or 
create a slot
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Holes/Pads not Normal to Sketch Plane
You will learn how to create Holes, Pockets or Pads with a direction of 
extrusion not perpendicular to their sketch 
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Some Key Points:

• When creating a hole, a pocket or a pad, the
default result is perpendicular to the sketch 
you have selected to get these features

• It is possible to define another direction. You 
specify it in the Direction field

• The selected direction must neither be in a 
plane parallel to the sketch plane nor in the 
same plane

What are Holes/Pockets/Pads not Normal to the Sketch Plane ?
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Holes/Pockets/Pads not Normal to Sketch Plane

1 If a Pad or Pocket, select 
Profile sketch to be used 2

De-Select 
“Normal to 
Sketch”
and select 
reference

3
For this geometry, modify definition 
to include type “Up to Plane” and 
select 

Changes
the
extrusion 
direction

4

Select the appropriate 
icon

5
Select limit 
surface on part 

You get: 
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First, you will design a Hole along a direction provided to you.

Do It Yourself (1/3)

Plane.1

Part used: Pockets_Not_Normal_to_sketch_plane_Do_It_Start.CATPart

Create Hole 
on this Pads 
face

Create the Hole 
along this direction

Locate the sketch for the hole on Pads face and constrain it with the planes and as shown:
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Do It Yourself (2/3)

Create the Hole along the direction shown.

This Line is provided in the 
Geometrical set



Student Notes:

Part Design
����������	��

Copyright DASSAULT SYSTEMES �


C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Do It Yourself (3/3)

Now you will create Pocket not normal to sketch plane.
Insert Body.2
Use following sketches provided in the Geometrical set:

“Sketch_For_Pocket” as profile for the pocket and 
“Direction_For_Pocket” as the direction for the pocket

Sketch_For_Pocket

Now you can apply tri-Tangent fillet to the Pockets and Pattern them using Circular pattern.
Finally, assemble this body with the part body.

Pockets_Not_Normal_to_sketch_plane_Do_It_End.CATPart
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Creating Pads and Pockets from Surfaces
You will learn how to create Pads and Pockets from Surfaces
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How to Create Pads and Pockets from Surfaces ?

You can extrude surfaces in any direction. Images below show you how to create pads from 
surfaces. The same method can be applied to pockets.

Up to Plane Up to Last

Up to next

Pocket from a Surface
(Up to Plane)
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Creating Pads and Pockets from Surfaces (1/2)

1

2

Select the Surface to be extruded. 

3 The Pad Definition dialog box 
appears. Select the “Up to surface”
limit and the surface of your choice. 
According to the example, you can 
use another limit type (Dimension 
limit, Up to next, Up to last, Up to 
plane …)

Select the Pad icon.
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Creating Pads and Pockets from Surfaces (2/2)

4 Expand the dialog box. Click the Reference Field and select the extrusion direction. 

5 Enter the first and the 
second limit values and click 
OK to confirm.
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Create a Pad from the ‘Fillet’ surface in the ordered geometrical set.
Create a pad upto XY plane and
Use direction as XY plane.

Do it Yourself

XY plane

Surface to Pad

Part used: Pad_from_Surface_Do_It.CATPart
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Surface-Based Features
You will learn how to create advanced types of Surfaced-Based feature: Split, 
Thick Surfaces, Close Surfaces and Sew Surfaces.
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What is a Surface Based Feature and When to Use It (1/2) ?

• Thick Surface: Used to create solids 
from surfaces.  Material can be added 
from either or both sides of the surface

• Split:  Used to split a solid with either a plane 
or a surface.

There are four Surface Based Features
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What is a Surface Based Feature and When to Use It (2/2) ?

• Sew Surface:  Used to glue a surface 
feature to an existing 3D solid.

• Close Surface:  Used to take a closed surface 
and turn it into a solid.
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Split 

1 Select body to be split 2

Select the splitting 
element

3

Select Split icon

An arrow pointing to the material 
to keep appears.  Click on it to 
reverse the direction if needed

You can split a body with a plane, face or surface.  A typical use is 
where the internal structure must be trimmed and associated to an 
outer aerodynamic shape to allow rapid future change.
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Thick Surface

1 Select the surface to be 
thickened.

2

Enter the offset thickness values.3

Select the Thick 
Surface icon.

First thickness value.

Second thickness value.

4

The resulting feature does not keep the 
color of the original surface.
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Close Surface 

1 Select Close Surface icon 2

Closed Surface appears in 
specification tree

3

Select surface to be closed
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Sew Surface 

1 Select the surface to sew2Select the Sew Surface icon

An arrow pointing to the material 
to keep appears.  Click to change 
the direction if needed.

Two options are available in the Dialog Box : 
Intersection and Simplify geometry. After clicking 
on the Intersection option, the Surface will be glued
to the existing 3D Solid even if this Surface 
intersects the Solid.

3 The Final solid is as follows

Sewing means joining together a surface and a body. This capability 
consists in computing the intersection between a given surface and a body 
while removing useless material
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Do It Yourself

• Using the “Split and Thickness” surface create a 
Split of the left pad and then create a Thickness
from the same surface (3 mm thick)

• Use the Sewing surface to create a curved surface 
on the end of the part using Sew

Sewing Surface

Split and Thickness
surface
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3D Constraints
You will learn how to use 3D constraints
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A 3D Constraint is the same as any other constraint only that it is applied in the 
3D model itself.  Basically you will note that some are reference type constraints 
and others are regular constraints. Creation is the same as in the Sketcher, so 
we will concentrate on their usage here

What is a 3D Constraint ?

Normally, 3D constraints are modifiable and can be linked and driven as 
others are in the Sketcher

They are references because there are other 
constraints that are constraining the geometry

Reference constraints are shown in 
parenthesis and cannot be modified
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They can be used whenever you have 3D geometry that you want to link to some 
type of 3D datum plane or surface

When to Use 3D Constraints ?

You may also find it useful when you are using Copy and Paste to locate 
the pasted piece of Geometry from where you wish

They are also useful when you need to drive the location 
of a piece of geometry created earlier in the design from a 
piece of geometry created later in the model.  Thus this 
will limit some of the need to re-ordering of the part
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Creating 3D Constraints

1 Select the Constraint icon and create a constraint between the left side face 
and the hole on the left side of the part

2 Now, Create one more 3D constraint between the 
same face and Hole on right side

The first dimension created was not a ‘reference’ dimension. No 
Parenthesis were on the value.  The second dimension was a 
‘reference’ dimension because the sketch of right side hole is 
constrained from right side face.



Student Notes:

Part Design
����������	��

Copyright DASSAULT SYSTEMES ��

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Using 3D Constraints

1
You will drive the location of Pocket.1 
from Hole.2 created after it in the tree

2

Modify the constraint indicated in red to 
25mm and the Pocket.1 is now driven 
from the Hole.2 location

3

Create the two constraints shown below 
from the center line of Hole.2 to the 
edges of the Pocket.1

Note: This capability will allow you to drive 
location of features in the tree from 
features created after them without having 
to do re-location of features in the tree.
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Exercise
3D Constraint Creation : Recap Exercise

Creating some 3D constraints to drive the location of the 
pads created before the holes from the hole location

15 min
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CATPDGEX3d_Constraint_start.CATPart.CATPart

Hole

Pad

Do It Yourself

• Constrain the Pad to the hole so that if the hole moves the pad 
moves with it

• Note that the Pad must be created before the hole so that the 
hole will pass through it after creation
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Using 3D Elements Recommendations
You will see some hints, tips and advices about tools seen in the lesson
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Local Axis dialog box

Defining Local Axis

To expand the 
dialog box 

To define the axis system origin 

To define the OX axis

To define the OY axis

To define the OZ axis

To reverse the OZ axis

To reverse the OY axis
To reverse the OX axis
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You can define Endpoints or Midpoints as origin points of Axis Systems.

Creating Midpoint or Endpoint to Define Axis System Origin 

With the option Create Midpoint : the origin 
point corresponds to the midpoint detected 
by the application after selection of a 
geometrical element.

1 2 The Axis System Definition 
dialog box is displayed.

3

4

Select the Insert -> Axis System 
command or click on the Axis 
System icon.

5

Use the contextual commands 
available from the Origin field to 
define the origin point. You can see 
that two new options have been 
added in V5R10 : Create Midpoint
and Create Endpoint.  

With the option Create Endpoint : the 
origin point corresponds to the endpoint 
detected by the application after 
selection of a geometrical element.
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Using 3D Elements to Create a Part: Recap 
Exercises
You will Practice the concepts learnt in this lesson to build a exercise following 
a recommended process.

Curved Mating Piece
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Curved Mating Piece
Using 3D Elements to create a part: Recap Exercise

25 min

In this exercise you will:
Design the part to connect two different 
components. A reference surface is provided.
Create a pad using the surface provided.
Create 3D wireframe elements to assist designing 
of the mating Rib.
Create Axis system and 3D points to locate tapered 
holes.
Apply fillets.
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Design Process: Curved Mating Piece

Create 3D elements to 
create a Rib

Add final dress-up 
features to complete 

the design

Create a Axis system to support 
the development of other feature

4

3

2

Create a solid feature from a 
surface

1
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Set the Length units to “Inches”, using:
Tools > Options > Parameters and Measure > Units.
Create a wireframe plane offset from XY plane at a distance of 3 inches downwards.
Rename the PartBody as “Main Body”.

Do It Yourself (1/12)

Plane.1

PDG_Curve_mating_Piece_Start.CATPart
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Do It Yourself (2/12)

Create a line normal to the surface 
Line type option: Normal to surface
Select surface.1
To select a point on this surface, you need to create the point using stacking 
of commands. Access the contextual menu and select “Create Point”.
Select Point type: On Surface

Point.1

Line.1
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Do It Yourself (3/12)

Create a pad from the surface and select direction as line.1 up to plane.1

Now, you will create a Rib. So, you will first design the center curve and then the profile for 
the Rib

Surface.1

Plane.1
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Do It Yourself (4/12)

Create a Rib along the top surface of the Pad that is designed to clip into 
another part. The transition for the center curve is offset asymmetrically from 
the ends. 
Create 3Dpoint on the edge of the of the pad.

Create the point on the edge of the pad using “On curve “ option.
Key in length 0.25in.

Point.2

Point.3

Create another 3Dpoint on the opposite edge of the of the pad.
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Do It Yourself (5/12)

Create a 3D line through these points and lying on pad top surface. This is the 
center curve for the Rib.

Point.3

Point.2
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Do It Yourself (6/12)

Now you will create a profile on the face of the pad in Main Body.

Profile 
for the 
Rib

Create sketch on this 
face.

The sketch Details are:
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Do It Yourself (7/12)

Create a Rib from the profile and center curve.

Sketch.1

Line.1

Reference 
Surface

The center curve must lie on reference surface   
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Do It Yourself (8/12)

Note how the opposite end of the Rib overhangs the Pad. You will use this face of 
the Rib to extrude a new Pad down to the base of the first Pad. Note the warning 
message. 

This face 
overhangs the 
Pad.

Select this edge 
as direction.
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Do It Yourself (9/12)

Now you will create an Axis System and 3D Points to help you place two tapered 
holes.
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Do It Yourself (10/12)

Now create two points in this axis system to locate the centers of two holes 
which you will create.

Point.4 (0.45, 1, 0)
Point.5 (0.45, 2.5, 0)

Point.4

Point.5
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Do It Yourself (11/12)

Use the hole tool to create a tapered hole on this face, coincident with the 
bottom 3D Point. (Hint: Select the hole tool, the reference 3D Point and then the 
face and the coincidence constraint will be automatically created.)
Select the hole parameters as shown below:

Blind Hole. Create it along pad edge.
Diameter of 0.4 in
Depth of 1in
Tapered hole with angle of 15 deg.

Similarly, create another hole using point.5

Hole.1

Hole.2

Direction
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Do It Yourself (12/12)

Apply an Edge fillet to the two edges of 0.125 in as shown.

Select these 
two edges

PDG_Curved_Mating_Piece_End.CATPart
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Angle Bracket
Part Design Fundamental Exercise

40 min

In this exercise you will build the Angle Bracket by 
following a recommended process.

You will first understand the design intent of the 
Angle Bracket and identify its functional features.

You will then study its Drawing in detail to understand 
the dimensions and specifications.

Finally,you will design the various functional features 
of the Angle Bracket according to specifications and by 
making use of  wireframe elements.

Here you will :

Design the base pad.

Design the thin pad.

Apply Fillets. 

Design bracket pad. 

Design pilot and Bracket Holes.
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Angled Bracket is a Machined component.
Angle Bracket is used in structures.
Base pad is used for clamping and for providing support.
Bracket Pad is used to hold Pins.

Design intent: Angle Bracket

Thin Flange

Base Pad

Bracket Pads

Pilot Holes

Fillets

Bracket Holes
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Angle Bracket Drawing

Understand the drawing thoroughly to design the part according to the
specifications.
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Design process: Angle Bracket (1/2)

Apply Fillets

Design the 
Base Pad

2

Design the 
Thin Flange

4

3

Create Wireframe 
specifications.

1
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Design process: Angle Bracket (2/2)

Design the 
Pilot Holes

Design the 
Bracket Holes

6

7

Design the 
Bracket Pad

5
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Step 1: Create Wireframe Specifications (1/3)

Open the part and understand the design intent behind the design. (The part has no history)
In a new Part, create a reference point with coordinates (76,0,0) in a Geometrical set.
Create another point at origin.
Create a line joining point.1 and Point.2.       

Point.1

Point.2

Point.1

Point.2

PDG_Angle_Bracket_Understanding_Design_Intent.CATPart. 
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Step 1: Create Wireframe Specifications (2/3)

Create a Point on line.1 at a distance of 27 mm form Point.2. This is Point.3.
Create a Line.2 of length 20 mm using “Point-direction” option.Use Point.3 and Z axis.
Create a Plane using YZ plane as reference and Line.2 as rotation axis.Rotation angle = 24 deg.

Point creation Line creation

Plane creation
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Step 1: Create Wireframe Specifications (3/3)

Create a plane at a distance of 65 mm from ZX Plane.
Create a plane at a distance of 8 mm from ZX Plane.
Plane.2 and Plane.3 are on either side of ZX Plane.

Plane.2

Plane.3

ZX Plane
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Step 2: Design the Base Pad 

Create a positioned sketch on XY Plane. Use Part origin and orient with X axis.
Use previously created wireframe elements to constrain the sketch.
Pad this sketch by a value of 4 mm in Part Body. This is the Base Pad.

Make this line coincident with Plane.3

Make this line coincident with 
Plane.2

Make this line perpendicular with 
Plane.1

Make center of the arc  
coincident with Point.1

Plane.2

Plane.3
Plane.1
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Step 3: Design the Thin Flange

Create a positioned sketch on YZ Plane. Use Part origin and Orient with Y axis. 
Use Plane.2 and Plane.3 to constrain this sketch.
Pad it by 3 mm.
This is Thin Flange Pad.

Plane.2

Plane.3
Details

Sketch for thin 
Flange



Student Notes:

Part Design
����������	��

Copyright DASSAULT SYSTEMES �	

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Step 4 & 5: Applying Fillets and Design the Bracket Pad (1/3)

Create a Point.4 on Plane.1 (H = - 35 and V = 20 mm). Use Point.3 as reference point.
This Point is Used later in the step.
Apply a Edge Fillet of 8 mm and 6 mm to the edges shown.
Create a positioned sketch on Plane.1.This is sketch.3.
Use Point.4 to constrain the sketch.

6 mm fillet 
8 mm fillet 

Point.4 

Constrain with 
Point.4

Constrain this line 
Pad.1 edge
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Step 4 & 5: Applying Fillets and Design the Bracket Pad (2/3)

Create Plane.4 offset from Plane.1 at a distance of 6 mm.
Create a Plane.5 offset from Plane.4 at a distance of 4 mm.
Pad sketch.3 by making use of Plane.4 and Plane.5 as limits. This is Pad.3

Plane.1 

Plane4 

Plane.5 

Plane4 

Plane.5 

Sketch.3 
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Step 4 & 5: Applying Fillets and Design the Bracket Pad (3/3)

Create Plane.6 offset from Plane.1 at a distance of 6 mm.
Create a Plane.7 offset from Plane.6 at a distance of 4 mm.
Pad sketch.3 using Plane.6 and Plane.7 as limits. This is Pad.4.
Apply Edge Fillet of 6 mm and 2 mm on the edges shown.

Plane7 

Plane 6 

Fillet of 6 mm.

Fillet of 2 mm to four 
edges shown
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Step 6: Design the Pilot Holes

Design the pilot hole of diameter 5 mm.
Create a Point in Geometrical set on Line.1 at a distance of 52 mm using Point.2 as
reference point.This is Point.5.
Create a sketch(consisting of points) in Geometrical set to pattern the pilot hole.
Use Previously Created points to constrain the points in the sketch.
Create a User Pattern of pilot hole using the above sketch.

Make the hole 
center 
coincident with 
Point.1

Make this point 
coincident with 
Point.3

Make this point 
coincident with 
Point.5

User Patterned 
holes
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Step 7: Design the Bracket Holes

Design the bracket hole of 6 mm upto Plane.7
Make the center of the hole coincident with Point.4  

The Resulting Part: PDG_Angle_Bracket.CATPart 
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To Sum Up 

This concludes the lesson on Using 3D elements to create Part

Local axis is used to define local co-ordinates . It is helpful create elements in reference 
with local system rather than absolute system.

Points,Lines and planes are used as reference elements to facilitate design.They also used 
for effective parent-children management.

You have seen how to create holes in a direction other than the direction Normal to sketch 
using 3d elements and also how to generate Pads and Pockets from surfaces.

In surface based features you have seen close surface,split surface,Thick surface and fill 
surfaces.

Split Surface :Used to split solid with a surface or a plane.

Thick surface:Used to create solids from surfaces by adding material in both the 
directions.

Close surface :Used to create a solid by closing a surface .

Sew surface:Used to glue a surface to a solid.
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Sketch-Based Features
You will learn how to create advanced sketch-based features

Introduction to Sketch-Based Features
Creating Ribs and Slots
Creating Stiffeners
Creating Multi-sections Solid
Sketch Based Features Recommendations
Sketch Based Features: Recap Exercises
Sum Up
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Introduction

Ribs and Slots:
These tools allow you to create complex ribs and 
slots on existing solids or to create pipes:

Stiffeners:
This tool is useful when you want to rigidify a thin solid:

Multi-sections Solids
This tool is used to create complex solid using a set of sections

Following advanced tools are Sketch Based and allow you to create complex parts:
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Creating Ribs and Slots
You will learn how to create Ribs and Slots

RIB

SLOT
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What is a Rib

A Rib is a profile swept along an open or closed Center Curve to create a 3D feature

The profile can be swept along an 
open or a closed center curve to 
create the feature.

The profile of the Rib can be 
controlled by simply using 
one of the 3 choices under 
the Profile control section of 
the window

The center curve does not have 
to extend to the end, merge 
Ends can be used to extend or 
shorten the rib to its proper 
wall.

Profile

Center curve
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What is a Slot

A Slot is a profile that is swept along an open or closed Center Curve to remove material 
from a solid

The profile can be swept along an 
open or a closed center curve to 
remove the material.

The profile of the Slot can be 
controlled by simply using one of 
the 3 choices under the profile 
control section of the window

The center curve does not have to 
extend to the end, merge ends can 
be used to extend or shorten the 
slot to its proper wall
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When Should We Use Ribs and Slots

You will find Ribs useful when you need to sweep 
profiles from one surface to another.

Ribs and Slots will also be useful to create complex 
walls of parts that have many details in them. Here you 
can control complexity in one sketch and does not 
require many small sketches or geometric features to 
work with.

Also a Rib can be used to create a pipe by sweeping a 
profile along a center curve.
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How to Create a Simple Rib

1 Select the Rib icon. 2

Set the Pulling direction by 
selecting the indicated surface

Select the Profile to be swept 
and the 3D center curve along 
which it will be swept. 

3 Click OK to validate the Rib4

The 3 Dimensional curve was created in the Wire Frame workbench.
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How to Create a Slot

1 Select the Slot icon 2 Select the Profile to be swept and also the 
path along which slot will be creates.

3 The  Result is:

The depth of the profile must 
be equal to or less than the 
radius of the Center Curve.
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Creating Thin Ribs and Slots (1/3)

You can create  a Thin Rib or Slot after 
checking the Thick Profile option

You then obtain your Thin Rib or Slot.

Thin  Ribs and Slots are resulting features from adding thickness to both sides of 
Rib’s and Slot’s profiles.
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Creating Thin Ribs and Slots (2/3)

1

2 Select the Profile you want to 
sweep and the Center curve in the 
Rib definition Dialog Box.

3 To define Thin Rib check Thick 
Profile option

4

Select the Rib icon 

Enter values for Thickness1 and Thickness2. 
You can see that material is added on both 
sides.
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Creating Thin Ribs and Slots (3/3)

5

If you click on the “Merge Ends” option, you will 
trim the Rib to existing material. 

6 Click OK to create your Thin Rib. 

This task can also be applied on Slots          
. The Thin Slot looks like this.

To add material equally to both sides, check 
Neutral Fiber. The thickness1 you defined is 
now distributed equally. Note that Thickness2 
is not available.



Student Notes:

Part Design
����������	��

Copyright DASSAULT SYSTEMES 	�

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Do It Yourself

• Create a Rib using Sketch.1 and Sketch.2
• Create a Slot using Sketch.3 along sketch.1

Sketch.1
Sketch.2

Sketch.3

RIB SLOT

CATPDGEXRib_Slot_Start.CATPart.CATPart



Student Notes:

Part Design
����������	��

Copyright DASSAULT SYSTEMES 	�

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Creating Stiffeners
You will learn how to create Stiffeners
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A Stiffener is a brace or rib that is added to a wall or a stand-off to strengthen them so 
as to prevent breakage.  It is commonly found on molded plastic parts or castings

What is a Stiffener ?

These two arrows are used to 
control the width of the part, which
can be either symmetrical or only 
on one side.

The other arrow is used to 
control the direction of the rib.

As with most features you 
can now access the sketch 
directly by selecting this 
button.
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They can be used when you have a thin wall that you want to be more rigid without 
increasing the thickness of the wall

When Should we Use Stiffeners ?

They can also be used for tall objects that are 
used to locate or support other objects and 
you want to prevent them from breaking off 
the surface they are attached to
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Creating Stiffeners (1/2)

1 Select the Stiffener Icon 2

3

Select the sketch

The Stiffener Definition Dialog box is displayed. 
Two Creation Modes are available : ‘From Side 
‘and ‘From Top’.

You will find that in many cases you need to add a small line segment on to the top of the angled line used 
to create your stiffener. This allows for a coincidence constraint to be created between the rib and the part.
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Creating Stiffeners (2/2)

5 The option ‘From Top’ allows you to create Stiffeners from a Network. It is never done with 
respect to the Creation order Profile. The extrusion is performed normal to the Profile’s Plane 
and the Thickness is added in the Profile Plane.

4 The ‘From Side’ option is the default one in CATIA. It is 
used to create “former” Stiffeners. The extrusion will 
be made in two Directions if the Neutral Fiber is 
uncheked, otherwise in three Directions. 

Select the thickness value. If the direction is correct 
select OK to create the Stiffener.
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Do It Yourself

• Create a Sketch on the Plane as shown
• Create a Stiffener of thickness 1 mm using this sketch.

Plane

Sketch

Stiffener

CATPDGEXStiffener_start.CATPart
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Creating Multi-sections Solid
You will learn how to create Multi-Sections Solids and Removed Multi-Sections 
Solids

Creating Simple Multi-sections Solids
Remove Multi-sections Solids
Coupling
Changing the Closing Point
Do it Yourself
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Creating Simple Multi-sections Solids
You will learn how to create Multi-sections Solids
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A Multi-sections Solid can be a Positive (add 
material) or Negative (subtract material) solid that is 
generated by two or more planar sections swept 
along a spine.

What is a Multi-sections Solid?

The Planar sections can be connected with Guide Lines.

Note that Closing Points on the sketch must be aligned to get the 
proper orientation of the sections otherwise the Multi-sections 
Solid gets twisted.

Directional arrows are provided to get the proper orientation of
the Multi-sections Solid.

Guide Line

Closing Point

In P1 configuration, only two 
sections Multi-sections Solid can 
be created.
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When to Use Multi-sections & Removed Multi-sections solids 

Removed Multi-sections Solids are used the same way when you 
want to subtract a transitioned surface from another solid.

Multi-sections Solids can be used for several reasons:

To create complex solids.

To create some transition geometry between two 
existing solids in a part
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Multi-sections Solid Creation: Guide Lines

1 Select the Multi-sections Solid icon 2
Select the sections through which the Multi-
sections Solid is going to pass. The order in 
which you select the sections is important, it 
will define the order of connection between 
the sections

The Multi-sections Solid passes 
through the sections and it is 
limited by the guide lines

(2a)

(2b) (2c)

3 Select the Guide tab from the dialog 
box

4 Select the Guide lines



Student Notes:

Part Design
����������	��

Copyright DASSAULT SYSTEMES �
�

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Multi-sections Solid Creation : Spine 

1 Select the Multi-sections Solid icon 2 Select the sections the Multi-sections Solid is 
going to pass through. The order in which you 
select the sections is important, it will define 
the order of connection between the sections

From the first to the last 
section, the solid is 
generated  by doing a 
sweep along the spine. 
The sections always stay 
fix in space 

(2a)

(2b)
(2c)

3 Select the Spine tab from the dialog box 4 Select the Spine

Spine
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Multi-sections Solid Creation: Closing Point & Orientation 

Orientation of the section

When selecting another section, it might happen that the 
section is orientated in the other direction than the 
previous one, so, to reverse the section orientation select 
the arrow which indicates the section orientation

Closing point of 
the section

To change the 
closing point of a 
section, select 
another point on this 
section
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Multi-sections Solid Creation : Tangent Surfaces 

1 Select the first section 2 Select the surface 
(corresponding to the first 
section) the Multi-sections 
Solid will be tangent to

3 Select the intermediate 
sections

4 Select the last section 5 Select the surface 
(corresponding to the last 
section) the Multi-sections 
Solid will be tangent to

6 Validate

You get :

Result with the same 
sections but without any 
tangent surfaces

(1) (2) (3) (4) (5)
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Removed Multi-sections Solids
You will learn how to create Removed Multi-sections Solids
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The Removed Multi-sections Solid capability generates Multi-sections Solid material, by 
sweeping one or more planar section curves along a computed or user-defined spine, and 
then removes this material. The material can be made to respect one or more guide curves

What is Remove Multi-sections Solid Material ?

In P1 configuration, only two 
sections Multi-sections Solid can 
be created.
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Remove Multi-sections Solid Material 

(1)

1 Select the Remove Multi-sections 
Solid Material icon

2 Select the sections the Multi-sections Solid is 
going to pass through. The order in which you 
select the sections is important, it will define 
the order of connection between the sections 
(You could have defined a spine or several 
guide lines, if no spine is selected, the system 
computes a spine for you)

(2a)

(2b)

(2c)

3 Select OK

(2d)(2e)
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Closing Point & Orientation: Remove Multi-sections Solid 

Orientation of the section

When selecting another section, it may happen that the 
section is orientated in the other direction than the 
previous one, so, to reverse the section orientation select 
the arrow which indicates the section orientation

Closing point of 
the section

To change the 
closing point of a 
section, select 
another point on this 
section
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Remove Multi-sections Solid Material : Tangent Surfaces 

1 Select the first section 2 Select the surface 
(corresponding to the first 
section) the removed Multi-
sections Solid will be tangent 
to

3 Select the intermediary 
sections

4 Select the last section 5 Select the surface 
(corresponding to the last 
section) the removed Multi-
sections Solid will be tangent 
to

6 Validate

You get : Result with the same 
sections but without any 
tangent surfaces

(2) (1) (3) (4) (5)
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Coupling
You will learn how to use Coupling when creating Multi-sections Solids
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What is Coupling when Creating Multi-sections Solids?

Vertices, 
Curvature 
Discontinuity, 
Tangency 
Discontinuity

Vertices, 
Curvature 
Discontinuity

Vertex

A Coupling tab in the Multi-sections Solid and remove Multi sections Solid functions allows 
you to compute the Multi-sections Solid using:

The total length of the sections (ratio).

The vertices of the sections.

The curvature discontinuity points of the sections.

The tangency discontinuity points of the sections.
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Coupling when Creating Multi-sections Solids 

1 Activate the Multi-sections Solid icon and select and 
orient the sections.

2 Select the Coupling tab from the 
dialog box 

The Coupling tab in the Multi-sections Solid and Remove Multi-sections Solid 
functions allows you to specify the Multi-sections Solid computation type: 
- on the total length of the sections (ratio)
- between the vertices of the sections
- between the curvature discontinuity points of the sections
- between the tangency discontinuity points of the sections

(2)

3 Select the desired kind of coupling 
from the combo

(1)

4 Select OK

(3)

(4)
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Coupling when Creating Multi-sections Solids: Ratio

1 Activate the Multi-sections Solid icon and select and
orient the sections.

2 Select the Coupling tab in the 
dialog box 

The Coupling tab in the “Multi-sections Solid” and “Remove Multi-sections Solid”
functions can be used to compute the Multi-sections Solid using the total length of 
the sections (ratio)

(2)

3 Select Ratio from the combo 

(1)

4 Select OK

(3)

(4)

The solid is passing through the sections and the variation between the 
sections is computed by a ratio corresponding to the length of each 
section

You get :
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Coupling when Creating Multi-sections Solids: Tangency

1 Activate the Multi-sections Solid icon and select and
orient the sections.

2 Select the Coupling tab from the 
dialog box 

(2)

3 Select Tangency Discontinuities 
from the combo 

(1)

4 Click OK

(3)

(4)

The solid is passing through the sections and each section is split at 
each tangency discontinuity point. The solid is computed between each 
split section

You get:

The Coupling tab in the Multi-sections Solid and Remove Multi-sections Solid 
functions can be used to compute the Multi-sections Solid between the tangency 
discontinuity points of the sections
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Coupling in Multi-sections Solids: Tangency then Curvature

1 Activate the Multi-sections Solid icon and select and 
orient the sections.

2 Select the Coupling tab from the 
dialog box 

(2)

3 Select Curvature Discontinuities 
from the combo 

(1)

4 Select OK

(3)

(4)

The solid is passing through the sections and each section is split at 
each curvature discontinuity point. The solid is computed between 
each split section

You get :

The Coupling tab in the Multi-sections Solid and Remove Multi-sections Solid 
functions can be used to compute the Multi-sections Solid between the curvature 
discontinuity points of the sections



Student Notes:

Part Design
����������	��

Copyright DASSAULT SYSTEMES ���

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Coupling when Creating Multi-sections Solids: Vertices 

1 Activate the Multi-sections Solid icon and select and
orient the sections.

2 Select the Coupling tab in the 
dialog box 

(2)

3 Select Vertices from the combo 

(1)

4 Click OK

(3)

(4)

The solid is passing through the sections and each section is split at 
each vertex. The solid is calculated between each split section

You get:

The Coupling tab in the Multi-sections Solid and Remove Multi-sections Solid 
functions can be used to compute the Multi-sections Solid between the vertices of the 
sections
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Coupling creation: Points of Discontinuity 

These two points are tangency 
and curvature discontinuity 
points. They are also vertices 

This point is a tangency and 
curvature continuity point. 
This point is a pure vertex

To have a look at the different types of 
discontinuity, we have sketched the profile 
shown below :

There are different types of point that CATIA can use to split the sections when 
creating Multi-sections Solids using coupling

Segments 

Two 
arcs

These two points are 
curvature discontinuity 
points. They are also 
vertices
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Multi-sections Solid Manual Coupling (1/2)

Activate the Multi-sections Solid icon, select the 
sections and the guide curves (if necessary, 
change the section orientation) 

Double click in the Coupling field to 
display the Coupling window 

1 2 Select the Coupling tab then set 
the Sections coupling to Ratio

When the sections to be Multi-sections Solid ,do not have the same number of 
vertices you can define manual coupling instead of changing or creating 
additional closing points.

You get:
Section 1Section 2

Section 3

Guide 1

Guide 2

Guide 3

3
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Multi-sections Solid Manual Coupling (2/2)

For each section select the vertex for the coupling. selection must be made in the same 
order in which the sections were selected.You can visualize the coupling curve if the 
corresponding option is checked. 

4

5 Click OK to end Multi-sections 
Solid surface definition

When the sections to be Multi-sections Solid ,do not have the same number of 
vertices you can define manual coupling instead of changing or creating 
additional closing points.

Coupling curves are 
displayed in green

a
b

c
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Manual Coupling: Displaying Uncoupled Points(1/2)

For each coupling mode, the points that could not be coupled are displayed in the 
geometry with specific symbols

1 2Select the two sections which have different 
number of vertices and have some 
discontinuity in curvature and tangency

Section 1
Section 2

Apply  the different coupling modes one by one

For each coupling mode, the points that could not 
be coupled are displayed in the geometry with 
specific symbols

3 An error is issued every time
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Manual Coupling: Displaying Uncoupled Points(2/2)

For each coupling mode, the points that could not be coupled are displayed in the 
geometry with specific symbols

Tangency mode : uncoupled 
tangency discontinuity points 
are represented by a square

Tangency the Curvature mode : 
Uncoupled curvature discontinuity 
points are represented  by an empty 
circle

Vertices mode : uncoupled 
vertices are represented by a 
full circle

4a 4b 4cTangency mode Tangency then 
curvature mode

Vertices mode
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Multi-sections Solid Relimitation (1/3)

When the limitation option is checked, the Multi-sections 
Solid is limited to the start or (and) end sections even is a 
larger spine or guide curves have been used

By default the Multi-sections Solid surface is limited by the 
start and end sections. However you can choose to limit it on 
the spine or on the guide lines extremities

Note: This is also possible with the Remove 
Multi-sections Solid command
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Multi-sections Solid Relimitation (2/3)

When the limitation option is unchecked, and 
when a spine has been used, the Multi-sections 
Solid is limited by the spine extremities

By default the Multi-sections Solid surface is limited by the 
start and end sections. However you can choose to limit it on 
the spine or on the guide lines extremities

Note: This is also possible with the Remove 
Multi-sections Solid command
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Multi-sections Solid Relimitation (3/3)

When the limitation option is unchecked, and 
when guide lines have been used, the Multi-
sections Solid is limited by the guide lines 
extremities

By default the Multi-sections Solid surface is limited by the 
start and end sections. However you can choose to limit it on 
the spine or on the guide lines extremities

Note: This is also possible with the Remove 
Multi-sections Solid command

Note: If a spine an guide lines have been used 
the Multi-sections Solid will be limited on the 
shorter line
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Changing the Closing Point
You will learn how to change the closing point when creating a Multi-sections 
Solid
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When selecting the sections to create a Multi-sections Solid (or remove Multi-sections 
Solid), you can change the closing point after the selection of the sections and you can 
create a closing point anywhere on a section profile

What is Changing the Closing Point when Creating Multi-
sections Solids ?
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Changing the Closing Point in Multi-sections Solids (1/6) 

1 Activate the Multi-sections Solid 
icon and select the first section

2 Select the second section 3 Select the third section 

First  section 
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Changing the Closing Point in Multi-sections Solids (2/6) 

4 Click on 
Section2 
(Label)

5 Select Replace Closing 
Point in the contextual 
menu, then select a 
new closing point (5)

(4)

(7) (5)

7 Select Replace 
Closing Point from 
the contextual menu, 
then select a new 
closing point (7)

(6)

8 Select the arrows to reverse 
Section2 and Section3 

(8)

6 Click on 
Section3 
(Label) 
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Changing the Closing Point in Multi-sections Solids (3/6) 

9 Check that the coupling is at 
Ratio then Select Preview in 
the dialog box

You can see that the solid is twisted because the default 
closing point of Section1 is not aligned with the closing points
of the other sections 

(9)
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Changing the Closing Point in Multi-sections Solids (4/6) 

10 In order to create a closing point on 
Section1, select the Section1 label with 
MB3, then select Remove Closing Point

(10)

A new dialog box is displayed corresponding 
to the point creation on a curve

(11)

The point appears in blue before 
validation 

11 Then again, select Create Closing 
Point in the contextual menu
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Changing the Closing Point in Multi-sections Solids (5/6) 

12 Select the Distance on curve 
option 

13 Select the Geodesic option and 
Enter 100 as the Length 

14 Select OK 
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Changing the Closing Point in Multi-sections Solids (6/6) 

16 Select the Coupling tab 

17 Select Vertices 
option from the 
combo

18 Select OK

You get :
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Do It Yourself (1/6)

Part used: Multi_Sections_Solid_Do_It

Using the 3 visible Sketches, apply the different coupling modes and  change the closing 
point

Create the Multi-sections solid using the four coupling modes : Ratio, Tangency, 
Tangency then curvature, Vertices.

Study the impact of various combinations. Analyze the warnings that you may get.

when ‘Tangency then Curvature’
option’ is used, Points discontinuous 
in curvature are coupled together

when ‘Tangency’ option is used, 
Points discontinuous in ‘tangency are 
coupled together
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Do It Yourself (2/6)

Create a new Multi- sections solid using one or several guide curves provided
Differentiate the result from the result of the previous step.

Guide Curves

Sections

You will observe that the final result will take the shape of the Guide Curves provided. Also, note 
that the Guide curves MUST intersect the sections.
When you use Guide Curves, CATIA computes the Multi section solid irrespective of the Coupling 
modes. 
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Do It Yourself (3/6)

Create a Multi-Sections solid using sketch provided in the geometrical set for step 3.
You will get an error asking you to use a guide with a smaller curvature. 

You get this error, because if you edit the sketch 
you will see that one line is not horizontal but at an 
angle of 0.75 deg. To solve this error you need to 
provide ‘Angular Correction’ of 0.75 deg in Multi-
Sections solid definition.

Angular correction option is helps to smooth 
the lofting motion along the reference guide 
curves. This may be necessary when small 
discontinuities are detected with regards to the 
spine tangency or the reference guide curves' 
normal. 

The Deviation option helps to smooth the 
lofting motion by deviating from the guide 
curve(s).
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Do It Yourself (4/6)

Show the sketches in the geometrical set for step4.
We will create a Multi sections solid by defining the spine.

The Spine curve should be normal to the section plane and must be continuous in 
tangency.

Also you can explicitly create Spine in the Generative Shape design workbench
Here, you will make use of readymade Spine provided to you.

You will create two Multi sections solids here:
Create First Multi- section solid will use only the spine in part body
Create Second Multi- section solid will use both the spine as well as the Guide 

curves in a new body.
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Do It Yourself (5/6)

Now create the second Multi-sections solid using the spine as well as Guide curves 
in a new body

Part body is Hidden for the time being.
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Do It Yourself (6/6)

Now show the Part body.
You can notice the differences between the two Multi section solids
You can observe that spine only provides the shape to the solid. But when we also 

use Guide curves , the solid is created along Guide curves.

First Multi-
Sections solid

Second Multi-
Sections solid
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Sketch-Based Features Recommendations
You will see some hints, tips and advices about tools seen in the lesson
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You can edit the sketches of the profile and the center curve during the rib or slot 
creation or edition

Editing sketch during Rib or Slot Creation or Edition

Access to the 
profile’s sketch

Access to the 
center curve’s 
sketch
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If no sketch has been created when activating the Rib or Slot icon, you can access the 
Sketcher by selecting the Sketcher icon. When you have completed the sketch, you can 
exit the Sketcher and return to the Rib or Slot creation

Creating Sketch During Rib or Slot Creation

Select the Sketcher 
icon in the dialog box You could have used the same 

method to define the Center curve 
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You can use sub-elements of a sketch to create ribs, like for pads or pockets

Using Sketch Sub-Elements to Create Ribs
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You can use sub-elements of a sketch to create slots, like for pads or pockets

Using Sketch Sub-Elements to Create Slots



Student Notes:

Part Design
����������	��

Copyright DASSAULT SYSTEMES ��


C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

You can use sub-elements of a sketch to create stiffeners, like for pads or pockets

Using Sketch Sub-Elements to Create Stiffeners
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You can create Ribs and Slots from sketches including several closed profiles. These profiles 
must not intersect

Using Several Closed Profiles to Create Ribs and Slots

Rib Slot
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Sketch Based Features: Recap Exercises
You will Practice the concepts learnt in this lesson to build a exercise following 
a recommended process.

Jewel Case Core
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Jewel Case Core
Sketch Based Features: Recap Exercise

20 min

In this exercise you will :
Design the part to create the core geometry for the 
Jewel Case.
Create combine from two profiles perpendicular to 
each other
Design the strengthening and mating part rib on the 
back perimeter of the core geometry
Design the relief Rib
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Design Process: Jewel Case Core

Create Pockets

Create another relief  Rib on the 
central part of the Jewel Case

Create strengthening 
Rib

4

3

2

Create the rough design by 
combining the two profiles

1
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Set the Length units to “Inches”, through: 
Tools > Options > Parameters and Measure > Units.
Create a Combine from the two sketches given.

Do It Yourself (1/11)
Part used: PDG_Jewel_Case_Core_Start.CATPart

Sketch.2

Sketch.1

Combine
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Do It Yourself (2/11)

Create another sketch on XY plane by projecting the edge of the combine.
Create the remainder of the sketch using the Profile tool and trim it to form the 
closed profile for the Pocket.  

Projection
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Do It Yourself (3/11)

Create a pocket using this sketch using “Up to Next” option.
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Do It Yourself (4/11)

Create another sketch on XY Plane
Use the project 3D elements tool to project four bottom edges from the solid 
onto the sketch plane as shown.
Trim the edges to form sharp edges.
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Do It Yourself (5/11)

Create a pocket from this sketch 
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Do It Yourself (6/11)

You will now design the rib to strengthen the Jewel Case.
First create a sketch on the top face of the Jewel case. This is the rib center curve.

Use the Project 3D Elements tool to project three bottom edges from the solid 
onto the sketch plane as shown.
Complete the sketch. Projections

After projecting the edges, 
continue to create the sketch 
shown in black
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Do It Yourself (7/11)

Mirror the sketch about the central line.
This sketch is the center curve for the rib that you will create.

Mirror about this line
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Do It Yourself (8/11)

Now you will create the profile to be swept around this center curve using the Rib 
tool.
Create a new plane (Offset 2.438in from the ZX plane) to support the sketch for this
profile. 

Plane

Sketch on 
this plane

Details of this 
sketch are:
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Do It Yourself (9/11)

Create a rib using the two sketches.

Rib
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Do It Yourself (10/11)

Create a relief rib for the Jewel Box. Create a sketch on the top face of the Jewel 
case core as shown for the center curve of a new rib.
Create a new sketch for the rib profile using the same sketch plane you used for the
strengthening rib profile. Create the half-circular profile as shown, constraining the    
lower corner point to the center curve profile.

Plane.1

Center 
curve 
for rib

Profile 
for rib
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Do It Yourself (11/11)

Create a relief rib for the Jewel Box using these sketches.

PDG_Jewel_Case_Core_End.CATPart
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To Sum Up 

You have learnt to create advanced sketch based features like Rib,Slot,Stiffener,Multi-Section 
solids

Rib :Rib is feature that is created by sweeping a profile along a given part.

Slot:Slot is a feature that removes material and is used in a  similar way as Rib.

Stiffener:A stiffener is a brace that is added to a wall to strengthen it and prevent breakage. it 
is mostly used in casting components.

Multi-Sections solid: Multi-Sections solid is used to sweep several sections along a guided 
path.

Removed Multi-sections solid is a feature similar to loft but the difference is that it removes 
material

Multi-section solid can be created using guides,spines,couplings

Multi-section solids can be relimited using Relimitation. 

This concludes the lesson on the Sketch based features 
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Part Manipulations
You will learn how to manipulate part elements

Introduction to Part Manipulations
Scanning a Part
Design Using Boolean Operations
Cut, Paste, Isolate, Break
Sharing Geometries
Sketch Selection with Multi-Document Links
Part Manipulations Recommendations
Part Manipulations: Recap Exercises
Sum Up
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Introduction 

You will see in this lesson different tools used to manage 
features (cut, paste…), bodies (inserting, boolean operations), 
and how to create multi-model links
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Scanning the Part
You will see how to replay the construction history of a part.
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Scanning a part means to replay the construction history of a part and isolate temporarily 
any feature to work locally. By scanning a Part we can understand the complete steps that 
were followed to complete the  design.

What is Scanning a Part ?
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Scanning the Design Process

You can select ‘forward’ at 
each step to scan all steps

Here is a powerful tool to show the Part History step by step in order to visualize how the 
model is designed. Scanning the design is done through Edit > Scan or Define in work 
Object.
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Scanning a Part (1/2)

1

2 Use the Scan tools to navigate 
through the part structure

Select  Edit > Scan ... Menu option

Backward: goes to the previous feature in the 
tree 

Forward: goes to the next feature in the tree

Starting feature: feature active when starting 
scanning

Last feature: last feature in the tree

Play Update: replay the update of the geometry

Initial part

First to Update: goes to the first element to 
update and update it

Exit: when you exit the active feature becomes in 
work (it is underlined in the tree)

Display Graph: Make a dialog box appear displaying 
all the features belonging to the part

Structure: all feature are scan in the 
order of the specification tree
Update: all features are scan in the 
order of the update
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Scanning a Part (2/2)

The Mirror.1 feature is in work: you 
can make local changes

3

4

To work again on the 
whole part, click the 
last feature in the tree 
and select the Define 
in work option in the 
contextual menu 
(MB3)
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Define in Work Object :To create a intermediate feature especially during design 
modification stage, define in work object is used.This is done through contextual menu.
Define in work objects is useful when working with several bodies (in Boolean 
operations)

By using Define in work object you can create features in a body by working 
in that body.

What is Define in work Object ?

Here the entire part is created in the same 
part body

But after creation of Pad.1 Body.2 is 
defined in work object then top part will be 
created in the second Body.
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Defining in Work Objects (1/2)

1

2

Select a feature in the Tree with MB1

Select the Define in Work Object option in the contextual menu

Note that in the same Body, CATIA no longer displays features coming after the ‘active’ feature defined as
in Work Object
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Defining in Work Object (2/2)

If you insert a new Sketch, it is positioned after the active feature(Feature that is 
underlined) defined as in Work.

3

Here Pad.1 is Defined in work Object. Here Shell.1 is Defined in work Object.
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Design Using Boolean Operations
You will learn to design parts using Boolean Operations and by managing 
bodies.

ADD

REMOVE

INTERSECT
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What are Boolean Operations?

The Three Basic types of Boolean operations  are:

1.Add (Union):Adding two solids, combines the two solids such that they become one 
solid. The exterior surface looks the same, however the two objects now act as one unit 
and can moved, copied and manipulated as a single entity.

2.Remove (Subtraction): Using Boolean remove on two objects, the second objects is 
removed from the first object. The first object remains as it is, except the “volume”
where the second object intersects the first object gets removed.

3.Intersect: Using Boolean intersection, the common volume or material to the two 
objects is kept.

Object 1 in Green

Object 2 in brown

ADD REMOVE INTERSECT
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Why do we need Boolean Operations ?(1/3)

We need Boolean operations for following Reasons:

1.Boolean approach facilitates design of complex parts.

2.To Optimize the design and Update of the part.

1. Design of Complex Parts

Boolean ADD: For example, 
you want to create the 
following complex part.

It can be designed easily by using Boolean operations 

Create Material 1 first Then, create Material 2 Add them together so that 
a single object is formed.
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Why do we need Boolean Operations ?(2/3)

Boolean operations are used to design the complex Parts

Boolean REMOVE: For 
example, you want to create 
the following complex part.

It can be designed easily by using Boolean operations 

Create Part 1 first Then, create Part 2 Remove Part 2 from Part 1 
to get the final single part.

It is required to get the 
precise fillet value here.
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Why do we need Boolean Operations ?(3/3)

Boolean operations are used to design the complex Parts

Boolean INTERSECT: For 
example, you want to create 
the following complex part.

It can be designed easily by using Boolean operations 

Create Part 1 first Then, create Part 2 Intersect part 1 and part 2 .    
Here Common part is kept
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How to Create Boolean Operations ? (1/2) 

To create Boolean operations we need parts designed in different bodies and not in in 
a single Part Body.

At a  given time Boolean Operations can be performed on two different bodies only.

To perform Boolean operations between the bodies ,you need to insert bodies through 
Insert > Body.

You can create different Design steps  in these bodies separately.

Now You will be able to perform operations (add, assemble,remove,intersect,union trim) to 
define relation between these bodies.

For example, to create a molded part. You can create Main part of the Mold in one body and the 
core in another body, then you can remove the core from the main part. 
Later it will be easy for you to separate the part and its core.
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Assembling/Adding :When Body2 is Assembled or Added with Body1, the operation 
between the bodies is a Union.The only difference between them is that Assemble will 
respect the “nature” of features.  If Body2 contains Pocket feature (permissible) as its 
first node , Assemble will remove material from Body1. If Add is used, the Pocket will be 
seen by Body1 as a Pad.

How to create Boolean Operations? (2/2) 

Intersecting : The resulting solid is the material common the 
two bodies.

Removing : If Body2 is Removed from Body1, the operation 
is Body1 minus Body2

Union Trim : The Union Trim is basically a Union with an 
option to remove or keep one side or the other.  In the 
picture, the purple face is selected to be removed.  For the 
Union Trim to work, the geometry must have sides that are 
clearly defined

Remove Lump : All the above options work between two 
bodies.  The Remove Lump works on geometry within a 
specific Body.  “Lump” is the material that is completely 
disconnected from other parts in  a single Body . The user 
can delete any Lump as a single entity even if the Lump is a 
combination of numerous features
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With the cursor on Body.2, select 
Assemble from the contextual menu 
(MB3)

We want to assemble Body.2 
with PartBody

Assemble 2

1

You get:

Body.2 contains a 
groove

Because Body.2 contains a 
groove which is a feature that 
removes material, the result of 
the assemble operation is also 
removing material

Select OK in the Dialog box3

In a complex part, when features are numerous 
it is useful to group together some of them in a 
body which becomes a subassembly of the first 
body using Insert in new body tool.
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With the cursor on Body.2, select Add 
from the contextual menu 
(MB3)

We want to add Body.2 in 
PartBody

Add 2

1

You get:
Body.2 contains a 
groove

Body.2 contains a single groove, 
so it appears as a solid (even if it 
normally removes material). When 
you Add a Body, CATIA keeps the 
feature like it appears before the 
addition.

Select OK in the Dialog box3
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With the cursor on Body.2, select 
Remove from the contextual menu 
(MB3)

We want to remove Body.2 
from PartBody

Remove 2

1

Select OK in the Dialog box3

You get:
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Intersect

We want to intersect Body.2 
with PartBody

1

With the pointer on Body.2, select 
Intersect from the contextual menu 
(MB3)

2

Click OK in the Dialog box3

You get:
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Union Trimming Bodies

We want to do a Union Trim 
of Body.2 with PartBody

1

With the pointer on Body.2, select Union 
Trim in the contextual menu 
(MB3)

2

Select the Face to remove then 
the face to keep

3

You get:

Click OK4
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Removing Lumps (1/3)

Cavity 

After certain operations, it may happen that some Lumps or Cavities appear in the 
part. We need to remove them. The Remove Lump capability allows you to remove 
Lumps and Cavities

Lumps 

Shell 

Pockets 
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Removing Lumps (2/3)

With the pointer on PartBody, select Remove 
Lump in the contextual menu (MB3) 

1

Select the ‘Faces to remove’ field in the dialog 
box 

2

Select the two following faces belonging to the 
lumps to be removed

3
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Removing Lumps (3/3)

In order to select a face of the cavity, place the 
pointer on the cavity to be removed then press 
the Up arrow key of the keyboard 

4

Using the small arrows, highlight one of the 
cavity face

5

To confirm the face selection click 
inside the circle6

Click OK7

You get:
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Assembling a Set of Bodies (1/3)
Assembling a set of bodies (Multi selected using 
the Ctrl key) is possible

Using the Ctrl key, select 
the three following bodies 
to be assembled

1



Student Notes:

Part Design
����������	��

Copyright DASSAULT SYSTEMES �	�

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Assembling a Set of Bodies (2/3)

With the cursor placed on the last body, select the 
Assemble option in the contextual menu2
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Assembling a Set of Bodies (3/3)

Select OK in the dialog box3

You get:
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What is Replacing a Body?

You can replace a body used in an operation by another one
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Select the Replace command 
from Body.3 contextual menu

Replacing a Body (1/3)

1Body to be 
replaced

Replacing 
body

Select Body.42
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Select the following line in 
the dialog box

Replacing a Body (2/3)

3

Select the following face in 
the Replace Viewer. This face 
is the face that will be 
removed during the Union 
Trim operation

4

Select OK6

Select OK5
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If necessary, update the part 
by selecting the Update All 
icon

Replacing a Body (3/3)

7

You get:
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Changing the Boolean Operation Type (1/4)

The initial part is composed of three 
bodies. Assemble Body.1 to Part 
Body.

1

Remove Body.2 from Assemble.1.You obtain 
Remove.1.

2
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Changing the Boolean Operation Type (2/4)

Click with the right button mouse on 
Remove.1. In the contextual menu, 
select Remove.1 object

3

Choose now the new operation. For 
example, click on Change To 
Assemble.

4
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Changing the Boolean Operation Type (3/4)

You obtain :5

Change now Assemble.2 to Union 
Trim. You obtain :

6
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Changing the Boolean Operation Type (4/4)

You can edit Trim.1. For instance, 
select the cylinder's top face as the 
face to keep. You obtain :

7
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Cut, Paste, Isolate, Break
You will see how to cut or copy a feature and paste it into a body and you will also see how to isolate or 
break 3D geometry from its parents 
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The operation Cut/Copy and then Paste captures the node specified into the clipboard and 
either replaces (Cut) or copies (Copy) the content into a different selected point in the part 
structure. The action is interpreted by the system in a context-sensitive manner. For example, if 
a pad is copied onto a different sketch, the new sketch is used for the profile and information 
on extrusion limits will be those of the pad. However, if pad1 is copied onto pad2, since this 
action has no real meaning, it is interpreted as generically copying the clipboard’s content into 
the part. The effect is to create another copy of pad1 (with its original sketch) in the part 
structure. This copy will be placed after whatever node is currently the “In Work” node.

What is Cut/Copy and Paste (Drag and Drop)?

Cut/Copy then Paste can be achieved by using the drag and drop capability. If the CTRL key is 
pressed during the drag and drop, the action is interpreted as a copy otherwise as cut.
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Cut/Copy and Paste (Drag and Drop) (1/3)

21
Select the feature that you want to copy on 
another feature from the tree.Copy Pad.2

paste the Pad feature on sketch.3.Select 
Sketch.3,click MB3,and select paste.

3 Pad.3 is created on sketch.3 
with the same limits as those in 
Pad.2
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Cut/Copy and Paste (Drag and Drop) (2/3)

5

4 Copy Draft.1 from the tree.Select the vertical 
face of the Pad.3 and Paste it using MB3.

Draft.2 is applied to Pad.3.
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Cut/Copy and Paste (Drag and Drop) (3/3)

6 Keeping the Ctrl Key pressed, select 
Edgefillet.1.

7 Drag the selection and drop it on one of the 
edges of Draft.2.
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• Isolate is used when 3D geometry is projected into a sketch in order to be modified and used 
as part of the sketch’s profile. Isolate duplicates the element since the original element cannot 
be changed because other geometry depends on it.

When to Use Isolate and Break?

• Break is used to divide an isolated element into two parts at a specified point (usually to use 
one side of this element in the sketch).
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Using the Trim and Break icon in the 
sketcher, modify the sketch as follows, 
then exit the sketcher.

Starting with the geometry as shown 
below, we want to add a pad.

Isolate, Break (1/3)

21

Lines

Added pad 

Diameter 100

Pad

Intersection between the 
pad and the sketch plane

Diameter 50

Create a pad with 
an length of 20.

3
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Edit the Sketch of the 
first pad and change the 
circle diameter to 50.

Select the Undo icon (may be 
several times) in order to come 
back to diameter 100

Exit the sketcher (Sketch.1), if necessary, Update the 
part. You will get:

Isolate, Break (2/3)

5

6

4

Edit Sketch.2, place the cursor on the yellow line. Select 
Isolate from the contextual menu.

7
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Create two Coincidence between the 
isolated arcs and the cylinder and exit 
the sketcher

Exit the sketcher, if necessary, Update 
the part. You will get:

Edit the Sketch (Sketch.1) of 
the first pad and change the 
circle diameter to 50

Isolate, Break (3/3)

9

10

8
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Sharing Geometries
You will learn ways to Share Geometries using Multi-model links to help 
propagate design changes.
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Introduction

Here you will learn to Share geometries between several parts by keeping the link. 

The link will be maintained between the Source part and the part in which copy is done.

To do so, you will learn what are Multi Model Links 
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The concept of working within an independent “Body” and then having the ability to Add, 
Remove, or Intersect this Body with your “Master” PartBody gives you added modeling 
flexibility

What are Multi-Model Links ?

There are different ways that an independently modeled Body 
can be assimilated into a PartBody
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In the context of the concurrent engineering, Multi-Model Links enable to keep the link between 
a copied element and its master. 

This allows to share geometries coming from different designers into your own part and it 
enables to update your part whenever different designers modify their design.

Why do we need Multi-Model Links ?(1/2)

Part Created By Designer A. Part Created By Designer B.

By using MML Part B is Imported in Part A
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Why do we need Multi-Model Links ?(2/2)

Part B is Removed from Part Using Boolean Operations

Part B is modified by Designer B The changes are reflected in the 
Master design A on update.
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In a CATIA session you have two 
separate parts

Establishing Multi-Model Links (1/3)
1

Using the Contextual Menu, copy 
the PartBody of Part22

Place the cursor on the PartBody
of Part1 then Select Paste Special 
from the contextual menu

3
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In the dialog box, select As Result 
With Link and the Paste button, 
then select OK

Establishing Multi-Model Links (2/3)

Part1 becomes:4

In Sketch.1 of part1, create a 
distance (10mm) between the circle 
and the copied cylinder then exit 
the sketcher

5

3
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Now, in Sketch.1 of part2, create a 
diameter constraint of 50 then exit 
the sketcher

Establishing Multi-Model Links (3/3)
Part1 becomes:7

With Part1 active, select the Update 
All icon

8

6

You get:
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Sketch Selection with Multi-Document Links
It is possible to copy and paste with link a sketch 
from a document to another one 
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Sketch Selection with Multi-Document Links (1/5)

After loading a part containing a 
sketch, start a new part using 
the File + New command

1

2 Display the two parts 
using the Window + 
Tile Horizontally 
command

You can copy a sketch in a document then paste it into another document keeping 
the link with the first one. You can use this copied sketch and in case the original 
sketch is modified, the document in which the copy is used will be also be modified

You get:
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Sketch Selection with Multi-Document Links (2/5)

With the cursor on Sketch.1 in 
the tree, select the Copy 
command from the contextual 
menu (MB3)

3 4 In the second part, place the cursor on 
PartBody, then select Paste Special 
from the contextual menu (MB3)

You can copy a sketch in a document then paste it into another document keeping 
the link with the first one. You can use this copied sketch and in case the original 
sketch is modified, the document in which the copy is used will be also be modified
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Sketch Selection with Multi-Document Links (3/5)

Select AsResultWithLink in the 
dialog box5 6 Expand Sketch.1 in order to see what 

has been copied (by selecting +)

You can copy a sketch in a document then paste it into another document keeping 
the link with the first one. You can use this copied sketch and in case the original 
sketch is modified, the document in which the copy is used will be also be modified
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Sketch Selection with Multi-Document Links (4/5)

Create a 20mm-high pad using 
the copied sketch7

8 In the first part, modify the sketch as 
shown below

You can copy a sketch in a document then paste it into another document keeping 
the link with the first one. You can use this copied sketch and in case the original 
sketch is modified, the document in which the copy is used will be also be modified
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Sketch Selection with Multi-Document Links (5/5)

To take the modification into account in the second part (the 
one which contains the copied sketch), place the cursor on 
Part2 then select the Part2object + Update All Links command

9

You get:

You can copy a sketch in a document then paste it into another document keeping 
the link with the first one. You can use this copied sketch and in case the original 
sketch is modified, the document in which the copy is used will be also be modified
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Part Manipulations Recommendations
You will see some hints, tips and advices about tools seen in the lesson
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The Different Paste Special Options (1/3)

� As specified in Part document:
The copied element can be 
modified and has no link with 
the original one. The original 
element is duplicated

As Result With Link: The 
copied element cannot be 
modified, but in case of 
modification of the original 
element, the copied one is 
updated

As Result: The copied element 
cannot be modified (it is a 
datum) and in case of 
modification of the original 
element, the copied one is not 
updated
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The Different Paste Special Options (2/3)

As Result With Link 

User can only select Bodies within the Part in which the Solid is defined.

You can edit the link of the solid which has been pasted in the same part using the 
option ‘As Result With Link’.

Two different configurations of Cavity Pockets 
are stored in the two bodies namely:
Cavity Pockets V1 and Cavity Pockets V2

Consider the following scenario:

Solid.9 is linked to one of the Cavity Pockets 
bodies and is used in Boolean operation with 
the part body.

By changing the parent link of Solid.9 you can 
obtain the required design configuration.

Cavity Pockets
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The Different Paste Special Options (3/3)

1 To change the parent of the pasted 
solid double-click its representation in 
the specification tree.

Solid.9 has been created by 
copying the ‘Cavity Pockets V1’
body and pasting it in the same 
part using the paste special 
option ‘As Result With Link’.

2 Select the another input for the solid as 
‘Cavity Pocket V2’.

The design has been changed to 
accommodate new Cavity Pockets
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Copying and Pasting Sketches

To paste a sketch from one document to another, right click the destination 
plane / face and select paste from the contextual menu. This method can 
avoid task of changing the sketch support which may be required later.
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Isolating Sketch Links

You can create an Implicit Projection by 
making dimensional or geometrical 
constraints between your sketch geometry 
and 3D elements outside the sketch.

If you display the Implicit Projection in Sketch 
Analysis, you can Isolate the projection even 
though no explicit geometry exists. This 
process creates the appropriate construction 
geometry in the sketch which is isolated from 
the original 3D elements.
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Part Manipulations
Recap Exercises

35 min

Adding and Assembling Bodies
Creating Union/Trim bodies
Copy/Paste Special bodies
Modifying Linked Geometry
Copying and Pasting Geometry 
within a Part
Copying and Pasting Geometry 
from one Part to Another Part
Creating 3D Constraints between 
Bodies
Connect Curves

In this step you will create:
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Design Process: Bracket-Right

1. Create new body
2. Union Trim the Bodies

4. Apply Symmetry to 
create Left Bracket 3. Copy/Paste Special

6. Modify Right Bracket
5. Add additional feature to 
Left Bracket

The process steps 
used to complete the 
exercise:
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Design Process: Final Jewel Case

The process steps 
used to complete 
the exercise:

1. Replicate the 
strengthening rib and 

make modifications to it

2. Copy Isolated 
geometry from 
another part for reuse

3. Copy geometry with 
history from another part for 

reuse

4. Add and Assemble bodies
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Bracket-Right Recap

� Add New design Feature as Separate Part 
Body 

� Union Trim two bodies 

� Use Copy/Paste Special to copy this design 
to a new part document

� Use Symmetry command to create the left 
handed Bracket

� Add hole feature which makes the left 
handed bracket different from the right 
handed bracket

� Modify the hole feature of the right-handed 
bracket, which will also modify the hoel
feature of the left-handed bracket because 
of the links.
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Final Jewel Case Recap

� Design intent to use existing features to 
finish the Jewel Case design

� Created an additional strengthening and 
mating part Rib by copying and then 
modifying the existing one

� Copied and Pasted as Result (isolated 
solid) features from another part to create 
CD placement ring

� Copied and Pasted features as Specified in 
Document to create flex openings for CD 
holder

� Added and Assembled bodies to complete 
the part
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To Sum Up

This concludes the lesson on the Part Manipulation tools.

Boolean operations are used to design complex parts.

Boolean operations are performed between  two bodies at a time.

Body is inserted through Insert > Body.

Different Boolean operations are

Add

Remove

Intersect

Assemble

Union Trim

Remove Lump:Used on the body on which Boolean operations are already 
performed.

Multi-Model links are used to propagate the design changes for one part to another.
Features can be dragged from one location to another ,also they can be copied. This is 

covered under Cut,Copy,Isolate, Break.
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Dress-Up Features
You will learn how to create advanced dress-up features

Introduction to Dress-Up Features
Advanced Drafts
Thickness
Removing Faces
Replacing a Face with a Surface
Dress Up Features Recommendations
Dress-Up Features: Recap Exercises
Sum Up
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Introduction 

Advanced Drafts:
This tool allows you to create complex drafts 
with a parting element or a reflect line:

Thickness:
This tool is useful when you want to 
add a thickness to a face:

The following advanced tools allow you to dress-up existing solids

Remove Faces:
This tool is useful when you want to simplify the 
geometry of a part for down stream processes:

Replace a Face with a Surface:
This tool is useful when you want to have a 
portion of the solid be extruded to a surface:
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Advanced Drafts
In this lesson you will see the Advanced Draft feature
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The Advanced Draft tool lets you draft basic parts or parts with reflect lines. It also lets you 
specify two different angle values for drafting complex parts. This task shows you how to 
draft two faces with reflect lines by specifying two different angle values and using the two 
available modes.

What is the Advanced Draft? (1/5)

By default, the Advanced Draft 
toolbar is not accessible from 
CATIA, so in order to get it, you 
will have to select

You will see the following toolbar:

Views -> Toolbars -> Advanced 
Dress-Up Features
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The Advanced Draft tool gives you the option to define standard draft as well as draft with 
reflect line on one or two sides. To do so, you will have to activate one or two buttons as 
described hereafter.

What is the Advanced Draft? (2/5)

Standard Draft (1st and 2nd

Side)

Standard Draft (1st side) Draft reflect line (1st side)

Draft reflect line (1st and 2nd

side)
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The 1st side tab is used to define the characteristics of the draft angle for the selected faces. 
If you decide to draft both sides, you have to define the draft angle characteristics for the 
second side using the 2nd side tab. When drafting both sides with reflect lines, you define 
whether the draft angles are independent or not.

What is the Advanced Draft? (3/5)

To define the Faces 
to be drafted.

To define the 
neutral element.

To define the 
pulling direction.

To define the draft 
angle value.

To define if the angles are the 
same or not when using draft 
with reflect line.
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To define the Parting Element, you have to use the parting tab. The parting element can be a 
plane, a surface or a face

What is the Advanced Draft? (4/5)

To define the 
parting element
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When you decide to draft both sides with independent angles, you have to define the 
second side characteristics

What is the Advanced Draft? (5/5)

Neutral element

To define the pulling 
direction

To define the draft 
angle value
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Advanced Draft Angle: Draft Both Sides (1/9)

Select the Advanced Draft 
icon

1

You are going to see how to draft both sides using the Advanced Draft icon

Activate these two buttons2
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Advanced Draft Angle: Draft Both Sides (2/9)

Select this face as the 
object to be drafted 

3
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Advanced Draft Angle: Draft Both Sides (3/9)

Select the indicated plane4
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Advanced Draft Angle: Draft Both Sides (4/9)

Enter 21 in the angle field5 Select the Parting Element tab6
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Advanced Draft Angle: Draft Both Sides (5/9)

Select the Parting Element button7 Select the Parting Element field8
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Advanced Draft Angle: Draft Both Sides (6/9)

Select the indicated plane9

Select the 2nd Side tab10

Select the 
required plane 
from tree or 
user can create 
plane by right 
clicking in 
selection menu 
as shown below
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Advanced Draft Angle: Draft Both Sides (7/9)
Select the indicated plane11
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Advanced Draft Angle: Draft Both Sides (8/9)
Enter 45 in the angle field12 Select Preview13
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Advanced Draft Angle: Draft Both Sides (9/9)

Select OK in the dialog box14

You will see

You get:
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Do It Yourself (1/2)

• Create a draft angle with the above indications. This 
draft angle is both sides with reflect lines

First Neutral 
Element

Second Neutral 
Element

10 degrees6 degrees

Face to define the 
Pulling Direction

Parting Element
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Do It Yourself (2/2)

• Modify the previously created draft angle by making 
the first angle value as the driving angle 
(Driving/Driven option)
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Thickness
You will see how to add material on a face by defining a thickness
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Why Applying Thickness?(1/2)

Applying thickness is basically used to enhance the productivity during solid model creation. 

A standard use of thickness is to add or remove material before machining a part. Thickness 
enhances the design intent and allows rapid modifications. 

Thickness is useful when you need to add material to various faces on a Part to 
accommodate machining or other manufacturing operations.  For instance, you might add 
Thickness to account for additional material necessary to cast the part. 

Thickness is also applied to select walls of a Part that has been Shelled.
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Now suppose we want to add thickness to one 
of the faces of the following part.

One of the methods is to create a pad,by selecting the face and specifying the length 
value.

Here you can observe that the filleted portion cannot be 
thickened in the Pad.To Pad that portion the number of 
steps would increase.

By using the thickness tool we can solve this problem quickly and 
efficiently.

Why Applying Thickness?(2/2)
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Creating a Thickness (1/2)

1 2

3

Select Thickness icon from 
Dress-Up features toolbar.

Thickness is applied to the selected faces.4

Select the faces to thicken.

Insert 10 as the Default thickness value.
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Creating a Thickness (2/2)

5 Now we want add different thickness value 
to other faces.To edit the feature,double 
click on the specification tree to open the 
thickness definition dialog box.

6 Select the indicated faces and enter 
the thickness value as 5mm.

7 The thickness applied to the other faces ,maintains the 
same relation with the other features.Here the thickness 
is created along the the two cylinders.

Enter 5 mm.
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Removing Faces 

You will see how to simplify a part by removing some of its faces or features.
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Why would you use this tool ?

When a part is to complex for of a finite element analysis you can remove some of its 
faces or features to simplify the geometry.

Remove Faces ICON

The feature in the 
Specification Tree 
contains the part without 
the removed features
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Faces are removed and a 
new feature is created in 
the specification tree

Removing Faces

1
2 Select internal faces 

which have to be removedSelect Remove Face tool

3

Contextual menu of Faces to 
remove field allows to select 
tangency propagation option 
which automatically removes 
all faces tangent to the selected 
ones.
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Remove internal faces of the keyway using Remove Face tool.

Do it Yourself

Part used: PDG_Removing_Faces_Start.CATPart
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Replacing a Solid Face with a Surface 

You will see how to replace a Face of a Solid by extruding it up to an external 
surface.



Student Notes:

Part Design
����������	��

Copyright DASSAULT SYSTEMES ���

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Select the replacing surface and 
click the arrow to make it pointing 
in the kept material direction 

Extruding a Solid Face Up To a Surface

1

3 Select the face to extrude

Select the Replace Face tool

You get the selected face extruded 
up to the replacing surface. Replace 
Face feature is added in the 
specification tree

2

4
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Replacing a Face with a Surface : Recap Exercise

Exercise

In this exercise you will extrude the bottom face of the solid up to the surface.

5 min
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Extrude the bottom face up to the yellow surface. 

Do it Yourself …

Part used: PDG_Extruding_Solid_Face_Up_To_Surface_Start.CATPart
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Dress Up Features Recommendations
You will see some hints, tips and advices about tools seen in the lesson
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Ignoring Faces When Creating a Thickness

In some cases, when you want to create an Offset, an error message appears informing 
you that the Body can’t built properly. After closing the window, another message 
appears proposing you to Ignore the Faces causing trouble. If you accept, the Thickness 
is created and the Face causing trouble is removed.

For example, here we want to offset the selected Face but it is not possible. The Face 
causing trouble is the Radius Fillet.

We accept to ignore the Fillet, thus the Thickened Body becomes :
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Reset Ignored Faces Option for Thickness Tool

If we edit the Thickness from the specification tree, the Ignored Faces are previewed :

The option “Reset Ignored Faces” appears in the Thickness Definition Dialog box. After 
selecting this option, the Ignored Faces are reinitialized and the indication “Ignored 
Face” in the geometry is removed.
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Extracting Geometry to Add Thickness

In some cases, you have to use the “Extract” command in order to add thickness. With this 
command, you can generate separate Elements from initial geometry, without deleting 
geometry. 

This command is available after clicking a Dialog box prompting you to deactivate the 
Thickness feature and Extract the geometry. Once this operation has been done, a node 
“Extracted Geometry” is displayed in the tree.

If the Generative Shape Design Workbench is installed, the geometry resulting from the 
Extract operation is associative.
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Dress-Up Features: Recap Exercises
You will Practice the concepts learnt in this lesson to build a exercise following 
a recommended process.

Plastic Molded Bracket
Crank Handle Bracket
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Plastic Molded Bracket
Dress-Up Features Recap Exercise

15 min

In this exercise you will :
Design the part to use it in an assembly and 
prepare it for manufacturing.
Design the Rough Part and make it thicker in order 
to meet the manufacturing requirements.
Apply a Draft to enable its withdrawal by  Molding 
manufacturing process.
Apply Fillets.
Create threaded Holes.
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Design Process: Plastic Molded Bracket

Apply drafts with 
different values

Create Holes. Apply 
threads to them.

Apply Fillets

4

3

2

Create the rough design by 
combining the two profiles

1
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Set the Length units to “Inches”, using: 
Tools > Options > Parameters and Measure > Units.
Create a Combine from the two sketches given.
Apply thickness of 0.15 inches to the Six faces shown.

Do It Yourself (1/5)

Sketch.1

Sketch.2

The 6 faces includes 
top and bottom faces

PDG_Plastic_Molded_Bracket_Start.CATPart
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Do It Yourself (2/5)

Apply advanced draft with following specifications:
Select Standard First and Second Side draft.
Number of faces to draft = 6.
Neutral element = ZX plane.
Draft angle value = 5 deg.

Select these 
three faces

ZX Plane
Also Select these 
three faces from 
bottom side
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Do It Yourself (3/5)

In the “2nd Side” tab set the following values:
Draft this side by 4 deg.

In the same Draft definition, access “Parting Element” tab
Use Parting Element as ZX plane.
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Do It Yourself (4/5)

Apply edge fillet of 0.75 inches to the 8 edges.
Create two Holes of 1 Inch diameter, concentric with the Circular edge.

Holes of 1 
Inch diameter
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Do It Yourself (5/5)

Apply Threads to both the holes.

PDG_Plastic_Molded_Bracket_End.CATPart
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Crank Handle Bracket
Dress- Up Features Recap Exercise

20  min

In this exercise you will :
Design the part to use it in an assembly and prepare 
it for manufacturing.
Create a Pad apply fillet on it.
Add advanced draft to add material to part with non 
symmetrical parting surface.
Apply advanced draft with different angle values 
above and below the parting surface.
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Design Process: Crank Handle Bracket

3

2

1

5

4

Create the part main body

Apply Advanced Draft

Create end Pads

Mirror the part

Apply advanced drafts 
to the ends
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Set the Length units to “Millimeter”, through:
Tools > Options > Parameters and Measure > Units.
Create a pad of 20 mm from the the sketch provided.
Apply a draft of 2 deg to the face shown.

Do It Yourself (1/8)
PDG_Crank_Handle_Bracket_Start.CATPart
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Apply a variable radius fillet to the 4 elements as shown

Do It Yourself (2/8)

Fillet of 4 mm at 
this end

Fillet of 6 mm at 
this end
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Do It Yourself (3/8)
Prepare the part for the manufacturing process by applying Advanced Drafts 
Click the Advanced Draft tool and specify Reflect Draft First Side and Second Side  
with following specifications:

Select Driving/Driven option from the list.
Apply a draft of 4 deg and make sure that option “Driving side” is ON.
Set the pulling direction to be the Z-Axis. (Hint: Use the contextual menu).
Select any one fillet surface from the top fillet to be the neutral Element.

Draft angle of 4 deg
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Do It Yourself (4/8)
Select the parting element tab and select extrude.1 as the parting surface.

Select 2nd side tab
Select any one fillet surface from the bottom fillet to be the neutral Element

Advanced draft is created
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Do It Yourself (5/8)
Create a pad feature from sketch.2 with a height of 30mm
Create another pad feature from sketch.3 with a height of 50mm.



Student Notes:

Part Design
����������	��

Copyright DASSAULT SYSTEMES ��	

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Do It Yourself (6/8)
Prepare the part for the manufacturing process by applying Advanced Drafts to the 
ends. Click the Advanced Draft tool and specify Standard Draft First Side and 
second side. 
Select the two cylindrical faces as the faces to Draft.
Key in 4deg for the 1st side Angle.
Make sure the option “ Neutral=Parting” is selected.
Use the XY plane as the pulling direction.

Standard first side 
and second side
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Do It Yourself (7/8)
Click the parting element tab in the dialog box and specify Extrude.1 as the parting 
element

Click the 2nd Side tab. Set the Draft Angle to 6deg for this side.
Make sure the option “Neutral=Parting” is selected.
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Do It Yourself (8/8)
Advanced Draft is created.
Finish the part using Mirror:Click the mirror command and use the flat surface as 
the mirroring element.

Advanced Draft

PDG_Crank_Handle_Bracket_End.CATPart
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To Sum Up 

This concludes the lesson on the Dress up features

You have seen the Possibilities of Advanced drafts.

Using apply thickness tool enables to apply thickness to a solid and helps to 
improve the productivity during Modification stage.

By removing faces you can remove the faces of a  complex solid so as to easily 
perform Finite element analysis.
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Part Analysis
You will learn how to use different kinds of analyzing tools

Introduction to Part Analysis
Analyzing Threads and Taps
Draft Analysis
Surfacic Curvature Analysis
Part Analysis: Recap Exercises
Sum Up
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Introduction 

Threads and Taps Analysis:
Useful when you want to visualize threads 
and taps contained in a part and to have all   
information about them:

Draft Analysis:
This tool is used to analyze the ability 
of a part to be extracted for mold 
design:

Surfacic Curvature Analysis:
Used to detect defaults on high quality 
surfaces:

Different kinds of analysis tools are available:
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Analyzing Threads and Taps
You will learn how to display and filter out information about threads and taps 
contained in a part
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When a part has been created with threads and taps, CATIA does not physically display 
these features. There is a way to quickly know all the information about threads and taps 
by using the Thread and Tap Analysis icon

What is Thread and Tap Analysis ?

• You can display threads or taps or both

• You can display the threads and taps 
numerical values

• You can display threads or/and taps of a 
given diameter value
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Analyzing Threads and Taps (1/2)
You can display and filter out information about threads and taps 
contained in a Part 

Select the Tap – Thread 
Analysis icon

Expand the dialog box 
using the More button

1

2

Select the criteria that will define the 
types of thread / tap that will be 
displayed

3

To show the threads 
or taps geometry 

To show the 
threads or taps 
values To show diameters 

with a given value

To show taps

To show threads
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Analyzing Threads and Taps (2/2)

Select Apply in the dialog 
box

You get:
4
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Draft Analysis
You will learn how to use the Draft Analysis tool to analyze the Draft values.
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Why Analyze Draft? 

For mold design, Drafts need to be analyzed to determine the ability of the part to be 
extracted. 

This type of analysis is based on color ranges identifying zones on the analyzed element 
where the deviation from the Draft direction at any point, corresponds to specified values. 
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Draft Analysis (1/3)

1

2 Select the Draft Analysis icon           and the element you want to analyze.

3 In the Draft Analysis dialog box, choose the quick 
analysis mode (default mode) or the full analysis mode.

Select the Material option in the View -> Render Style -> Customized View 
command to see the analysis results on the selected element. 

Double-click a color to modify the values 
in the color range or a value to modify the 
edition values.

4

Quick

Full
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Draft Analysis (2/3)

4 You can activate the fly analysis check box and move 
the pointer over the surface. This option allows you to 
perform a local analysis.

Arrows are displayed under the 
pointer: Green arrow is the 
normal to the surface at the 
pointer location, red represent 
draft direction and blue arrow is 
the tangent.

The displayed value 
indicates the angle between 
the draft direction and the 
tangent to the surface at the 
current point.



Student Notes:

Part Design
����������	��

Copyright DASSAULT SYSTEMES �
�

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Draft Analysis (3/3)

5 Select         to define the new current draft direction.

A compass giving the 
current draft direction 
is displayed (the draft 
direction is the w axis 
of the compass).

6 You can edit the compass proprieties to precisely 
define the draft direction.

The red areas represents all that cannot be extracted 
with the current draft direction.
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Surfacic Curvature Analysis
You will learn how to use the Mapping Analysis tool to analyze surface 
curvature.
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Why Curvature Analysis? 
Curvature analysis of surfaces in generally used to help model high quality surfaces ie to 
detect the defaults on high quality surfaces. The Mapping analysis tool allows you to measure 
minimum and maximum curvature values of a point, the mean value (Gaussian analysis) and to 
see the inflection areas.

Gaussian

Limited : to check if tool with an end radius can mill the part.

Inflection area : to define the curvature orientation. In 
green : areas where the minimum and maximum 
curvatures have a same orientation, In blue : they have  
opposite orientation.

Minimum (Maximum) : to display the 
minimum  (maximum) curvature value.
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Performing a Surfacic Curvature Analysis

1

2 Select the Curvature Mapping icon         and the surface where you want to 
examine the curvature.

3 The Surfacic Curvature dialog box appears. Select 
Gaussian as Analysis Type.

Select the Material option in the View -> Render Style -> Customized View
command to see the analysis results on the selected element. 

4 Adjust the color range fields right 
clicking on the thresholds values.  

… you obtain :

On the fly 
enables to 
perform a 
local analysis
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Part Analysis Exercises
Recap Exercises

25 min

Performing a Curvature Analysis
Performing a Structure Scan Object
Performing an Update Scan Object
Performing a Tap and Thread 
Analysis
Performing a Draft Analysis

In this step you will create :
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Design Process:  Wrench Analysis

1. Perform a Gaussian 
Curvature Analysis

2. Modify the analysis 
color scale display

3. Perform an Inflection Analysis

The process steps 
used to complete the 
exercise:
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Design Process:  Flanged Connector

1. Scan the relationship 
of features in the Part

2. Analyze Tap and Thread 
information in the Part

3. Analyze selected features of the Part for 
manufacturability through Draft Angle ranges

The process steps 
used to complete the 
exercise:
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Wrench Analysis Recap

� Design intent to analyze the curvature of a 
wrench design having many curved surface 
features

� Performed a Gaussian curvature analysis

� Modified the color scale values and colors 
for better clarity of the analysis

� Performed a curvature inflection analysis
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Flanged Connector Recap

� Performed a Scan Analysis for features in 
Structure Mode

� Performed a Scan Analysis for features in 
Update Mode

� Analyzed Tap and Thread information for 
the Part

� Performed a Draft Analysis for selected 
features on the part to determine 
manufacturability
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To Sum Up 

This concludes the lesson on the Part Analysis tools.
You have learned how to:

Analyze Threads and Taps:Used when you want to visualize threads and taps in a 
part and to have all  information about them>you can apply filters on the selection.

Analyze Drafts:This tool is used to analyze whether a  part can be extracted for 
mold design.A Color range is displayed identifying different zones of the analyzed 
part.

Analyze Surfacic Curvature:Used to detect faults on high quality surfaces.



Student Notes:

Part Design
����������	��

Copyright DASSAULT SYSTEMES ���

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Annotations
You will learn how to add annotations in the 3D area

Introduction to Annotations
Text with Leader
Flag Note with Leader
Annotations Recommendations
Annotations: Recap Exercises
Sum Up
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Introduction 

Text with Leader:
This tool allows you to add text attached to 
a part:

Flag Note with Leader:
This tool allows you to add flag note 
attached to a part :

You will see how to add text information attached to a part in the 3D geometry
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Text with Leader
You will learn how to attach a text to a part
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A text with leader can be attached to a part in order to give information for example 
on surface treatment. This text can appear on the drawing

What are Texts with Leader ?

Text

Leader
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Select the Text with 
Leader icon

Texts with Leader

1
Select the position of the 
leader on the part2

Enter the text in the dialog box 
then select OK

3

Place the text and the leader by 
dragging the arrow or the square 
points

4

You get:
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Do It Yourself

• Create the following text with leader  

CATPDG_Doit_Text_with_Leader.CATPart
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Flag Note with Leader
You will learn how to add hyperlinks to your document and then use them to 
jump to a variety of locations
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A flag note with leader can be attached to a part in order to give information for 
example on surface treatment. This flag is an hyperlink that can start any documents 
such as a presentation, a Microsoft Excel spreadsheet or a HTML page on the intranet

What are Flag Notes with Leader?
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Enter Part Process in the Name 
field

Select the Flag 
Note with Leader 
icon

Flag Notes with Leader (1/2)

1

Select the position of the 
leader on the part2

3
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Flag Notes with Leader (2/2)

You get:

Place the text and the leader by 
dragging the arrow or the square 
points

5

Select the Browse button then 
select the file you want to link then 
select OK 

4
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Select the Go to button in the 
dialog box 

Double click on the 
flag

Using Flag Notes with Leader

1

Select the Link in the dialog 
box2

3

The linked file is now started 
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Annotations Recommendations
You will see some hints, tips and advices about tools seen in the lesson
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Modifying a Text With Leader

Double click

To Modify the text of a text with leader, double click on the text, you will recover the dialog 
box where you can change the text

Using the Properties command in the contextual menu will give you access to text, font 
and graphic modifications
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Modifying The Text of a Flag Note With Leader

To Modify the text of a flag note with leader, double click on the text, you will recover the 
dialog box where you can change the text

Using the Properties option in the contextual menu will give you access to text, font and 
graphic modifications

Double click

You can have several files linked to a flag note
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Repositioning 3D Annotation

You can use the Handles to reposition and resize the Annotation feature.

Use this handle to 
reposition the arrowhead

Use this handle to reposition 
the end of the arrow

Use this handle to reposition the 
Annotation along its leader line

Use top or bottom handles to move 
the Annotation up and down

Use middle handles to adjust the 
width of the Annotation box
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Changing 3D Annotation Properties

You can modify the graphic, feature and other Properties of an Annotation through 
contextual menus.

Use the Properties menu to 
modify font color, size, feature 
name and other properties of 
the Annotation

Use these contextual menus to 
modify other aspects of the 

Annotation
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Annotations Exercises
Recap Exercises

25 min

Creating text with a leader
Creating a flag note with a leader
Creating a projection view
Viewing hyperlinks

In this step you will create:
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Sensor Well Exercise: Design Process

1. Create a text note to 
identify a design issue

2. Define a new annotation projection view

3. Create a flag note with a hyperlink 
to a specification document

The process steps 
used to complete the 
exercise:
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Bracket Annotation Exercise: Design Process

The process steps 
used to complete the 
exercise:

1. Create 3D Text

2. Create Flag Note

3. View Hyperlink
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Sensor Well Recap

� Design intent to create a note to identify a 
design issue and a flag note with a linked 
specification document

� Created a text note with a leader attached 
to the end surface of the part

� Created a new annotation projection view

� Created a flag note with a hyperlinked 
Excel document
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Bracket Annotations Recap

� Design intent to create a note to explain a 
design change and a flag note with a linked 
manufacturing document

� Created a text note in the part

� Created a flag note in the part including a 
hyperlink to a Word document

� View the contents of the hyperlink
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To Sum Up 

This concludes the lesson on the annotation tools.
You have learned how to:

Create Text with Leader
Create Flag Note with Leader
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In this course you have learned how to design parts using advanced 
tools and to analyse and manipulate parts …

In addition, you have built a mobile ‘Phone Bottom Case’
following a recommended design process ...

Congratulations


